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This software is supplied as is without warranty or representation either express or implied with 
respect to the program or its documentation including their quality, performance, merchantability, or 
fitness for a particular purpose.

In no event will Oakley Data Services or any of its agents or assigns, or any organization distributing 
SmartSum on its behalf be liable for direct, indirect, special, incidental, or consequential damages 
arising out of the use of, or inability to use the program.

All trademarks are acknowledged.
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Introduction

SmartSum is a Windows based implementation of an adding machine/printing calculator. It also has 
a number of tricks that a normal printing calculator cannot do.

· Audble feedback can be selected to ensure accuracy of input. SmartSum can optionally be 
configured to vocalise the digits as entered, the operators as entered and the results of 
calculations. The supplied sounds can be replaced by the user to allow for different languages 
etc.

· Calculations can be saved and re-loaded.
· Incorrect entries can be corrected.
· Entries can be deleted.
· Additional entries can be inserted.
· Decimal accuracy can be changed at any time in a sequence of calculations, and the whole 

sequence will be re-calculated.
· Subtotals and entry counts can be displayed or hidden at will.
· Notes can be added to inividual entries and to the results of calculations
· Tax calculations, such as the addition of VAT(TVA) in Europe or State Sales Tax in the USA are 

simplified by the inclusion of three "TAX" buttons which can calculate Tax-Inclusive price given a 
Tax-Exclusive price and Vice-Versa. The tax rates are user-defineable.

· The tally roll can be printed using any available font, or copied to the clipboard.
· Macros (recorded sequences of keystrokes) can be used to simplify repeated calculations. A 

number of useful macros are supplied, such as conversions from gallons to litres, farenheit to 
celcius etc. You can also record your own macros or export them to and import them from other 
sources.

· Macros can request user-input at various stages of the calculation.
· Ten memories are available for more complex calculations.
· Calculation results can be injected automatically into another application, such as a spreadsheet.
· Entries can be "checked off".
· Calculations can be titled. The title is saved and reloaded with the calculation, and printed with 

the calculation.
· The display's colors can be reconfigured as desired.
· An "always on top" mode is available.



Click on the area of interest in the screenshot below
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Rounding Errors when using 2,4 or 6 Decimal Places
When you set SmartSum to use 2, 4 or 6 decimal places, you can introduce small errors because of 
the "rounding" that occurs. For example if you set decimal places to say "2", and enter 10 divided by 
6, the result will be 1.6666666666 recurring, which SmartSum will round as requested to 1.67.

If you then multiply by 6, you will get a result of 10.02, not the 10 you started with. This is due to the 
effect of rounding the first calculation to 2 decimal places.

Switching to fully-floating decimal will always give the correct result to the limit of the accuracy of the 
numeric co-processor your PC has, or the emulation of it Windows undertakes if your PC does not 
have a co-processor.

Tax Calculations
Asuming you have set the correct rate using the "Tax Rate" option of the "Entries" menu, you can 
quickly perform sales-tax type calculations. For example to add tax at 17.5% to an item with a value 
of 25.00 first enter the value 25.00, then press the "+" button followed by the "Tax a" button, and the 
resultant tax-inclusive cost of 29.38 will be displayed. The tally-roll will show that the tax component 
is 4.38, and the "a" sign to the right shows it has been automatically calculated by use of the "Tax a" 
button.

Similarly if you have an item priced at 41.07 including tax at 17.5% then you can calculate the tax-
exclusive cost by first entering 41.07, then pressing the "-" key followed by the "Tax a" key, which will 
give a result of 34.95, and a tax component of 6.12. Again, the 6.12 will have "a" to the right on the 
tally roll to indicate it was calculated automatically by use of the "Tax a"" button. 

Copying to the Windows Clipboard
"Tally-Rolls" copied to the windows clipboard are padded with spaces to display correctly if a non-
proportional font is used. You can see the effect of a non-proportional font on the clipboard by 
selecting "OEM-TEXT" from the "View" menu of the Clipboard viewer. You may also need to use a 
non-proportional font (such as Courier) if you paste the information into another document.

Printing
You can usually print successfully using a proportional font, and the figures will line up OK because 
in most proportional fonts the sizes of the numeric characters are in fact all the same. However, this 
isn't always true, and if you do get "wiggly" printing you have little choice but to change font.



Copyright © 1994 Oakley Data Services
Call +44 (0)1270 759739, Fax +44 (0)1270 765272, CIS 74774,1347

Menu Commands:-
Select the Menu of interest:-
File Menu
Edit Menu
Entries Menu
Macros Menu
Options Menu
Help Menu



File Menu Commands
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File Menu
New
The New command clears the Tally Roll and completely resets the calculator. Note that it doesn't 
warn you if you haven't saved the current calculation.

Keyboard Shortcut - "Alt + W"

Open
The Open command reloads a previously saved calculation.

Keyboard Shortcut - None

Save
The Save command will save the current calculation, using the filename the calcuation was last 
saved as. If SmartSum does not have a current filename then this option will not be available.

Keyboard Shortcut - None

Save As
The Save As command allows you to specify a filename via a standard File Save dialog box. The 
calculation is then saved to that file. A warning is given if the file already exists.

Keyboard Shortcut - None

Print
The Print command prints the current calculation. The print will have the same style as the displayed 
"tally roll", with subtotals and entry counts if they have been selected. Each page of the "tally roll" will
be headed by the entry in the title box.

Keyboard Shortcut - "Alt + P"

Printer Font
The Printer Font command allows you to select the font you wish to use for printing. Take a look at 
the General Information topic in this Help File for some hints on selecting fonts.

Keyboard Shortcut - None

Printer Setup
The Printer Setup command allows you to select which printer to use. Unless instructed otherwise by
using this command, SmartSum uses the default Windows printer.

Keyboard Shortcut - None

Exit
Closes SmartSum. Note that there is no warning if you haven't saved or printed the tally roll.



Keyboard Shortcut - None



Edit Menu Commands
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Edit Menu
Copy
The Copy command places the contents of the "tally roll" onto the Windows Clipboard, from where it 
can be pasted into other documents such as Word Processors. The data placed on the clipboard will 
have the same style as the displayed "tally roll".

Keyboard Shortcut - None

Copy Result
Copies just the number currently displayed in the "Main Display" to the Windows Clipboard.

Keyboard Shortcut - "Ctrl + Ins"

Paste
The Paste command copies to the SmartSum display the number on the Windows Clipboard, as if 
you had entered it yourself via the keyboard. Note that the contents of the Clipboard have to be 
numeric!

Keyboard Shortcut - "Shift + Ins"

Inject
The Inject command takes the number currently in the SmartSum display and automatically pastes it 
into the target application at the current insertion point. The default target application is Microsoft 
Excel, but can be changed. To define the target application see the Options Menu commands.

Keyboard Shortcut - None. For technical reasons a keyboard shortcut cannot be implemented reliably

Find
Locates the first entry on the tally roll that has the value entered in the dialog box that is presented.

Keyboard Shortcut - None

Find Next
Locates the next entry between the currently selected entry and the end of the tally roll that has the 
value as previously entered in the "Find" dailog box.

Keyboard Shortcut - None



Entries Menu Commands
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Entries Menu
Amend Entry
The Amend Entry command allows you to change the currently selected entry on the "tally roll" 
(shown with a small > sign). The complete sequence is then recalculated. To select the correct entry 
for amendment simply click on it with the mouse, or navigate to it with the cursor keys. Double-
Clicking on an entry has the same effect.

Keyboard Shortcut - "Ctrl + Enter"

Insert Entry
The Insert Entry command allows you to insert a new entry on the "tally roll" immediately after the 
currently selected one. (shown with a small > sign). The complete sequence is then recalculated.

Keyboard Shortcut - "Insert"

Delete Entry
The Delete Entry command deletes the currently selected entry on the "tally roll" (shown with a small 
> sign). The complete sequence is then recalculated.

Keyboard Shortcut - "Ctrl + Delete"

Check Entry
The Check Entry command places a small "c" to the right of the currently selected entry on the "tally 
roll" (shown with a small > sign), and then advances the selection one step. Using this you can easily
"check off" a sequence of entries. If an entry is already checked it will be "unchecked". Using the 
Ctrl+Space keyboard shortcut is probably the easiest way to check off a sequence of entries.

Keyboard Shortcut - "Ctrl + Space"

Uncheck All
The Uncheck All command removes the checkmarks from all the entries on the "Tally Roll".

Keyboard Shortcut - "Ctrl + U"

Individual Subtotal
The Individual Subtotal command causes a subtotal to appear after the currently selected entry on 
the "tally roll", unless there is already a subtotal there, in which case it is removed. The § button 
below the tally roll has the same effect.

Keyboard Shortcut - "Ctrl + S"

Clear Individual Subtotals
This command clears all Individual Subtotals set with the "Individual Subtotal" command.

Keyboard Shortcut - "Ctrl + I"

Notes



Allows you to add, display or edit a note attached to the currently selected entry on the tally roll.

Keyboard Shortcut - "Ctrl + N"

Set Tax Rate "A", "B", "C"
This option allows you to set the Tax rates used in calculations when one of the three "Tax" buttons is
used.

Keyboard Shortcut - None



Macros Menu Commands
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Macros Menu
Macros are pre-recorded sequences of keystrokes that are automatically "replayed" to aid repetitive 
calculations. They can be written by the user, or imported from other sources. A number of useful 
macros, including a number of conversion calculations, are supplied with SmartSum.

For more information see the section "Writing Macros"
Execute
This menu item leads to a sub-menu which lists the first 24 macros, and a final entry "More..." which 
pops up a dialog box listing all 255 possible macros. Selecting one of the macros, either from its 
menu entry or from the "More..." dialog box, will cause the macro to execute.

Keyboard shortcut:- Macros 1 to 12 can be executed by pressing keys F1 to F12, and macros 13 to 24 will execute if 
keys F1 to F12 are pressed with the Shift key depressed.

Define
From this sub-menu you can select the macro you wish to define or modify.

Keyboard Shortcut :- None

Import
From this sub-menu you can select the macro you wish to import. A standard "File-Open" box is 
presented to allow you to select a previously exported SmartSum macro. Note that the file, normally 
with a "SSE" extension, is in a format unique to SmartSum, and cannot be effectively edited with 
other tools. If you want to copy/paste a macro sequence you can do so with the Ctrl+Ins and 
Shift+Ins key combinations from within "Define Macro" dialog box.

Keyboard Shortcut :- None

Export
From this sub-menu you can select the macro you wish to Export. A standard "File-Open" box is 
presented to allow you to select a name and location for the export file.

Keyboard Shortcut :- None



Writing Macros
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Basic Macro Concepts
A SmartSum macro is almost nothing more than a recorded sequence of keystrokes, but with 
thoughtful use can be an astonishing timesaver, and can also guarantee consistency across multiple 
users. Macros can be imported and exported, allowing authoring in one location and subsequent 
distribution across a wide user population.

A number of useful macros are provided with SmartSum, and a study of these will help you 
understand how macros work.

Defining the Macro
Selecting the "Define Macro" submenu from the "Macros" menu, and selecting a macro to define, 
leads to a dialog box that has three edit controls, in addition to the usual "OK" and "Cancel" buttons.

The first Edit Control, "Description", simply allows you to enter a description which will be useful to 
you or anyone you send the macro to in the future. It is not used by the macro processor in any way.

The second Edit Control, "Keystrokes", is where you type the actual sequence of simulated 
keystrokes that form the macro.

The third Edit Control, "Menu Text", allows you to define the text that will appear in the Menu to 
identify this macro, and to appear in the list box where macros 25-255 (which do not appear directly 
on the menu) are selectable.



Syntax Rules
The SmartSum macro syntax processor (the component that "reads" the macros you write) is simple,
and operates on two basic principles:-

· Anything that it doesn't understand is completely ignored. (Like spaces, line-ends and so on, 
allowing complete freedom of formatting).

· With the exception of the mechanisms for inputting notes and asking for user input, a macro 
operates exactly as it would if you had entered the same set of keystrokes directly into 
SmartSum using the keyboard.

Keyboard/Macro equivalents:-
Note - Apart from the text representing a note, the macro processor is not case sensitive.

Simple calculator operations
· The digit keys (0 to 9) are represented by the single characters "0" to "9"
· The decimal point is represented by the single character "."
· Plus, minus, times, divide and percent are represented by the single characters "+",    "-",    "*", "/" 

and "%" respectively
· Square Root is represented by the single character "s"
· Enter, or the equals button, is represented by the single character "="
Tax Operations
· The "Tax a", "Tax b" and "Tax c" buttons are represented by the single characters "a", "b" and "c" 

respectively
Tally Roll Management
· "New" is represented by the single character "~"
· "Clear" is represented by the single character "!"
Simple Memory Operations (which act on the currently active memory).
· "Memory Plus" is represented by the character pair "M+"
· "Memory Minus" is represented by the character pair "M-"
· "Memory Clear" is represented by the character pair "MC"
· "Memory Recall" is represented by the character pair "MR"
Advanced Memory operations
· Changing the active memory is achieved by the character pairs "M0" to "M9" respectively.
Soliciting Input from the User
· The user can be asked to enter a value any number of times during a sequence of calculations 

using the syntax:-

M?"Text to appear as prompt in dialog box"

Whatever value the user enters will be stored in the currently active memory, from where it can 
be recalled at any time using the "MR" command.

Take care to ensure that you don't forget the trailing quote, which is an easy mistake to make.
Adding notes to the tally roll.
· Notes can be added to the tally roll at any stage of the calculation, using the following syntax:-

N"Note by some input"



To add a note to the currently selected input value on the tally roll,or

R"Note by the result"

To add a note by the subtotal/total at this point.

Again take care to ensure that you don't forget the trailing quote!

Notes on when the tally roll selection changes
To use the notes option effectively it is vital to understand when the "currently selected item" on the 
tally roll changes. As stated before, it operates exactly as it does from the keyboard, and this can be 
a trap for the unwary.

For example, to enter the value 1234.56 and put a note saying "Income" beside it, and then deduct a 
value of 100 and put a note of "Income Tax" beside it, the following sequence WILL NOT WORK, 
although it looks as though it might:-

1234.56
N"Income"
-100
N"Income Tax"
=

The reason that it fails is because at the time the N"Income" command is issued, the value 1234.56 
has not been transferred to the tally roll. That will only occur when a subsequent operator (like the - 
sign) causes the tally roll to be updated. As stated before, this is exactly the same as SmartSum 
operates without macros. A sequence that would achieve the desired result is:-

1234.56 -
N"Income"
100 =
N"Income Tax"



Options Menu Commands
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Options Menu
Display Mode
Allows you to select from the five available decimal accuracy modes, 2,4 or 6 decimal places, fully 
floating, or "currency" mode. In currency mode the decimal point is automatically inserted so as to 
leave two digits to the right of it. So for example to enter the value 123.45 you merely need to enter 
the 1,2,3,4 and 5 keys in succession, the decimal point is not required.

Keyboard Shortcuts - "Ctrl + A", "Ctrl + F", "Ctrl + F2", "Ctrl + F4", "Ctrl + F6" as appropriate.

Paper Mode - All Subtotals
This command is a toggle which switches between the display of all intermediate results, and only 
the final result. The §§ button below the tally roll has the same effect. Note that individually assigned 
subtotals always display, irrespective of the state of this setting.

Keyboard Shortcut - "Ctrl + L"

Paper Mode - Display Entry Count
This command is a toggle which displays or hides the count of entries in a calculation. The (n) button
below the tally roll has the same effect.

Keyboard Shortcut - "Ctrl + E"

Sound Mode
Allows you to switch on or off the vocalisation of the digits and operators as you enter them, and the 
results as calculated. There is also a "global" on/off switch to control whether any part of macro 
processing is vocalised. If the "Say Macros" option is off, no part of any macro will be spoken. If "Say
Macros" is on, the various elements of macros will be vocalised according to the "say digits", "say 
operators" and "say results" settings.

Keyboard Shortcut - None

Tax Button Names
Enables you to define the legends you want to appear on each of the three "Tax" buttons. The hot 
key is defined as the key immediately following the character & in whatever you enter. For example 
giving a button a name of &VAT would cause Alt+V to become the shortcut. Note that you need to be 
careful not to duplicate any already existing shortcuts, or the results will be unpredicatable.

You can also completely hide a button if you want to by giving it no name whatsoever.

Keyboard Shortcut - None

Colors
This option allows you to configure the colors used by various parts of the SmartSum display. 
Depending on your video configuration you may only get an approximation of the color you select.

Keyboard Shortcut - None



Define Inject Target
You use this option to define the application that will receive an automatically pasted    copy of the 
total or subtotal at the currently selected item on the tally roll. When you select this option the mouse-
pointer will change to a needle/syringe. You should then move the mouse pointer over the application
you wish to receive injections and press the left mouse button. Note that anywhere over the target 
application is OK, you don't need to accurately pinpoint the position in the target application.

Keyboard Shortcut - None

Auto Subtotal
This option is a toggle which controls the effect of the "=" button (or its keyboard equivalent, the 
Enter key). If the option is set (i.e. there is a check next to the menu item), then pressing the "=" 
button causes a subtotal to be inserted at this point in the calculation. If the option is not set then no 
subtotal is automatically added, although one can be manually added by using the § button. 
Automatic subtotals can be removed in the same way as those added manually.

Keyboard Shortcut - None

Always On Top
This option is again a toggle, and when set causes SmartSum to remain above all other active 
windows even if it is not itself active, much like the similar option in Windows Help.

Keyboard Shortcut - None



Help Menu Commands
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Help Menu
Index
Jumps to the Contents Topic of this Help File.

Keyboard Shortcut - None

Keyboard
Jumps to the Keyboard Shortcut Topic of this Help File.

Keyboard Shortcut - None

Using Help
Jumps to Help on using Windows Help itself.

Keyboard Shortcut - None

About
Displays the About Dialog.

Keyboard Shortcut - None

Order Form
Jumps to an order form to register a copy of SmartSum.

Keyboard Shortcut - None



Keyboard Usage
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General
The program is designed such that the numeric portion of the keyboard works as much like a normal 
adding machine/calculator as possible. The numbers 0 to 9 and the decimal point operate as 
expected, and the +, -, *, / and % keys are for addition, subtraction, multiplication and division. For 
effective use the numeric lock must be set, and this will normally be shown by a light on the 
keyboard. The enter key has the effect of the = key on a normal calculator. The normal numeric keys 
accessed by the use of Shift and the top row of keys also function, as do the +,-,* and / keys on the 
main keyboard.

The "Clear" key is simulated by the PC's "Esc" key, and the PC's "Backspace" key provides a way to 
remove the last entered digit. The Ctrl and Minus key combination simulates the sign-change button.

For a complete list of shortcut keys for all the buttons on the calculator keyboard, refer to the 
section:-

The Elements of the SmartSum Screen

Menu Shortcuts
As well as the normal numeric keys required to operate an adding machine, there are shortcut keys 
for most of the menu commands as well. These are described under the description of each menu 
item in the following sections:-

File Menu
Edit Menu
Entries Menu
Macros Menu
Options Menu
Help Menu



If you haven't got a sound card
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Using the Speaker Driver
If you haven't got a sound card, don't worry, you don't need to miss out on the audible feedback that 
makes SmartSum such a powerful tool.

It is possible to make SmartSum "speak" through your normal PC Speaker, using the PC-Speaker 
driver which we have included with Smartsum and which will have been installed in your SmartSum 
Directory.

To make use of the Speaker Driver, you first need to "install" it, and the steps required are as 
follows:-

1 Start the Windows Control Panel, usually found in the "Main" group in Program Manager.
2 Double-Click on the "drivers" Icon to start the driver installation utility.
3 Click on the "Add" button.
4 Select "Unlisted or Updated Driver" from the list (it is usually at the top), and click on "OK".
5 When asked to insert the disk with the new driver on, type in the directory in which you installed 

SmartSum (usually C:\SMARTSUM) and click on OK. Alternatively you can click on the "Browse"
button and navigate to the correct directory.

6 Follow the instructions for configuring the driver, using the "Test" option usually provides good 
quality sound.

Some notes about the Speaker Driver
There is an option in the Speaker Driver configuation to run it with "interrupts disabled" which 
effectively means while it is vocalising a digit or phrase your PC will not respond to the keyboard or 
to mouse movements. Even if you elect to run with "interrupts enabled" some PC's seem to 
occasionally ignore the keyboard so you may need to experiment to see what works best for you. Of 
course if SmartSum has not accepted a digit you have pressed you will be alerted because you won't
hear it!

If you decide to replace the sounds provided with some of your own it is advisable to keep them fairly
short and crisp.



Replacing the supplied sounds
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It is very easy to replace the sounds supplied with ones of your own choice, perhaps to support your 
own language. Simply replace the SS1.WAV to SS21.WAV files in the SmartSum directory with your 
own. The correlation between the sound file and what it relates to appears below:-

· SS0.WAV to SS9.WAV are the digits "0" to "9"
· SS10.WAV is the phrase "point" ( . )
· SS11.WAV is the phrase "plus" ( + )
· SS12.WAV is the phrase "minus" ( - )
· SS13.WAV is the phrase "times" ( * )
· SS14.WAV is the phrase "Divided by" ( / )
· SS15.WAV is the phrase "Equals" ( = )
· SS16.WAV is the phrase "Per Cent" ( % )
· SS17.WAV is the phrase "Change Sign" ( +- )
· SS18.WAV is the phrase "Tax A"
· SS19.WAV is the phrase "Tax B"
· SS20.WAV is the phrase "Tax C"
· SS21.WAV is the phrase "Square Root" ( Sqrt )



Shareware
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This product is Shareware. Shareware is a form of software distribution, not free software. If you 
have not already registered this product, you have the right to evaluate it for a period of 30 days from
the date you initially install it. If you find that it suits your needs and you wish to continue to use it 
after the 30 day period you are required to register it by paying the registration fee to Oakley Data 
Services. There are significant advantages to registering your copy, not least the continued 
availability of good quality software at reasonable prices.

You also have the right, and in fact you are actively encouraged, to distribute copies of the 
Shareware version of this product. You may assume you have our authority to distribute this product 
unless we explicitly tell you otherwise. It must, however remain in its original, unmodified state, and 
all its constituent files must be included. No-one may charge for the program itself, although a 
reasonable fee for the media used and copying costs is allowable.

You may not distribute copies of the registered version of this product. You 
may not distribute the SMTSUM1X.DLL file in any form.

This software is supplied as is without warranty or representation either express or implied with 
respect to the program or its documentation including their quality, performance, merchantability, or 
fitness for a particular purpose.

In no event will Oakley Data Services or any of its agents, or assigns, or any organisation distributing
SmartSum on its behalf be liable for direct, indirect, special, incidental, or consequential damages 
arising out of the use of, or inability to use the program.

All trademarks are acknowledged.



Registering

Select the "Order Form" button on the reminder screen, or from the "Help" menu, for phone numbers 
and addresses.
You can register your copy of SmartSum by Phone, Fax, Mail or E-Mail. We accept cheques in 
Sterling, or VISA or Mastercard. If you have a CompuServe account you can also register via the 
SWREG service. SmartSum's SWREG product ID is 2705 and the price via this mechanism is 
currently 35 US dollars.

Printing an Order From
You can access an order form if you wish to register by Fax, Mail or E-Mail by pressing the 'Order 
Form' button on the reminder screen, or from the "Help" drop down menu. The order form shows the 
current registration fees and addresses and phone numbers.

Multiple Copy Licences
Registration of a single copy of SmartSum allows you to use it on a single PC, and to make back-up 
copies for security purposes. It does not permit installation on more than 1 PC at the same time, or 
use on multiple workstations connected to a network.

However, we do offer extremely attractive discounts for multiple-copy 
licences, allowing you to make SmartSum an integral part of your network, 
site or corporation. Please contact us for details.
Please let us know which version you currently have
If you register by phone, please let us know which version of the program you currently have (shown 
as R1.5 or similar on the program caption). This helps us greatly to determine how effective our 
shareware distribution methods are. If you use the order form the version number is already pre-
printed on it.



Upgrade Policy and Getting Support
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Upgrade Policy
The code (.EXE file) for the registered and unregistered versions of the program are identical, and it 
is the presence of a file SMTSUM1X.DLL that is supplied with the registered version that causes the 
program to behave in a registered fashion. The presence of the DLL will also cause any further 
versions of SmartSum that still bear the 1.x release number to behave as registered versions, 
wherever you obtain them from. Versions that bear the 1.x release number will generally be for minor
enhancements and bug-fixes. Any release containing major new functionality will bear the release 
number 2.x, and an upgrade fee will probably be chargeable.

We will make new versions of SmartSum available via the usual sources, online on services such as 
CompuServe,CIX and the Internet and via disk vendors, cover disks and CD's.

The prime locations for new releases are our support section on CompuServe, section 4 of the 
UKSHARE forum and our Internet site at www.smartcode.com.

If you do aquire a newer version of SmartSum simply ensure that the SMTSUM1X.DLL file you got 
when you registered is either in the directory that the SmartSum program is in, or is in your 
WINDOWS directory.

Getting Support
For support, please contact the agent who sold yoou the software. Full addresses can be found by 
selecting the "order form" option of the Help menu,

Or contact us via our support section on CompuServe, Section 4 of the UKSHARE forum, or the 
oakley conference on CIX.

This program is authored by:-

Oakley Data Services,
3, Oakley Close,
Sandbach,
Cheshire CW11 9RQ
England.

Phone: (+44) (0)1270 759739
Fax: (+44) (0)1270 765272
CIS E-Mail: 74774,1347
Internet: 74774.1347@compuserve.com



Main Readout
The main display shows digits as entered and provides a readout of results. You can alter to suit your
taste from the color from the Options menu.



The "M+" key
The M+ key adds the value currently displayed in the main display to the currently selected memory.

Keyboard Shortcut - "Alt +"



The "M-" key
The M- key subtracts the value currently displayed in the main display from the currently selected 
memory.

Keyboard Shortcut - "Alt -"



The "M rcl" key
The "M rcl" recalls the value from the currently selected memory to the main display.

Keyboard Shortcut - "Alt R"



The "M Clr" key
The "M Clr" key resets the currently selected memory to 0.

Keyboard Shortcut - "Alt L"



The "MS" key
The "MS" key switches control to the original calculator applet supplied with Windows. SmartSum 
automatically minimizes itself once the original calculator has started.

This can be useful when the original Windows Calculator provides some of th more esoteric functions
that SmartSum does not. You can also make effective use of Copy/Paste between the two 
calculators.

You can permanently replace the standard Windows Calculator with SmartSum, but still have the 
original calculator available from this button. See the section

Replacing the Standard Windows Calculator
for more information.

Keyboard Shortcut - None



Replacing the Standard Windows Calculator

Copyright © 1994 Oakley Data Services
Call +44 (0)1270 759739, Fax +44 (0)1270 765272, CIS 74774,1347
If you wish, you can replace the standard Windows Calculator with SmartSum, but leave the 
standard Windows Calculator available for those times when you wish to use some of the functions 
that it has that SmartSum does not (SIN, COS, TAN etc). You can then call the standard Windows 
Calculator by pressing the "MS" button on the SmartSum keyboard. You can also "cut & paste" quite 
effectively between them.

But why would I want to?
Because there are some third party applications that have automatic links to the Windows Calculator,
when you might now prefer that they jumped to SmartSum instead. But it would still be nice to be 
able to use the original Windows Calculator if the need arises.

So what do I need to do?
Follow these steps:-

1 Using File-Manager rename the original CALC.EXE file (probably in your Windows directory) to 
MS_CALC.EXE.

2 Copy the REP_CALC.EXE file from the SmartSum directory to the location of the original 
Windows calculator.

3 Rename the newly copied REP_CALC.EXE to CALC.EXE
4 Copy the file REP_CALC.INI to the same directory as the new CALC.EXE
5 Modify the last line of the REP_CALC.INI file (the "Directory=" line) so it points to the location of 

SmartSum. (Retain any trailing backslash).
(These steps may seem more complicated than absolutely necessary, but it does allow total flexibility
for example where networks are involved).

And how do I put it back the way it was?
To reinstate the original calculator simply reverse the process (i.e. delete the new CALC.EXE and 
rename MS_CALC.EXE to CALC.EXE).



Note Button
This button allows you to add a note to the currently selected item in the "tally roll". A dialog box is 
presented which allows you to place the note by either the input value or by the calculated total or 
subtotal.

Keyboard Shortcut - "Alt - t"



Tax Buttons
The three tax buttons provide a convenient way to perform sales tax/VAT/TVA type caclulations. The 
names of the Tax buttons can be modified from the "Options" menu, and the relevant Tax 
percentages can be set from the "Entries" menu. Setting the name of a Tax button to nothing will 
remove the button from the display.

The buttons are only functional after use of the + or - operators, and either calculate and add the 
relevant Tax amount to the current total, or calculate and subtract the relevant Tax amount from the 
current total.

For example, given a Tax Rate setting on Tax button "a" of 17.5%, the 
calculation:-
· 25.00 + TAX "a" = will give a result of 29.37
· 29.37 - TAX "a" = will give a result of 25.00
Keyboard Shortcut - Depends on the names given to the buttons by the user. The letter following any & character 
becomes the "Alt" key shortcut, but take care to avoid already used characters.



The memory display
The Memory display shows the contents of the currently selected memory.



"Individual Subtotal" Key
This key is a toggle (i.e. if on it switches off, if off it switches on) which adds or removes the subtotal 
at the currently selected position on the "tally roll"

Keyboard Shortcut - "Ctrl S"



"All Subtotals" key
This key is a toggle (if on switches off, if off switches on) which adds or removes subtotals at each 
step in the calculations on the "tally roll". Note that if you switch off all    subtotals using this key, some
may remain because they were added using the "individual subtotal" key.

Keyboard Shortcut - "Ctrl L"



Decimal Mode Selector
This control allows you to select the number of decimal places that calculations are rounded to, and 
whether or not to use "Currency" mode. Possible choices are 2,4 or 6 decimal places, fully-floating 
(no rounding), or currency mode.

In "Currency" mode there is no need to use the decimal point during input. All numbers are assumed 
to have two decimal places. For example, using the key sequence 2500 would cause the display to 
read 25.00. The easiest way to understand this option is to try it!

Note also that if you change mode then any previous sequence on the "tally roll" is recalculated 
using the new mode!

Keyboard Shortcut - "Ctrl A", "Ctrl F", "Ctrl F2", "Ctrl F4", "Ctrl F6" as appropriate.



"Entry Count" Key
This key is a toggle which switches on or off the display of the count of entries to the left of the "tally 
roll"

Keyboard Shortcut - "Ctrl E"



The "Inject" Key
Pressing this button causes the total at the currently-selected point in the "tally roll" to be "injected" 
into another application, at the point where the cursor is in that other application. The other 
application could be a spreadsheet, or a word processor.

To define the target for the inject command use the "options" menu.

Keyboard Shortcut - None. Unfortunately there are technical reasons why a keyboard shortcut cannot be made to 
work reliably.



The "Print" key
This key prints the tally roll on the currently selected printer (either the Windows default printer, or 
one selected by use of the "Print Setup" option from the "File" menu. The font used can be selected 
from the "Printer Font" option on the "File" menu.

Keyboard Shortcut - "Alt P or Ctrl P"



The "Calculation Title" box
You can enter text in this box as a "title". It will appear on print-outs and will be saved and re-loaded 
with the calculation.



The "Tally Roll"
This displays the sequence of calculations, to the decimal precision requested using the precision 
selectors located beneath the main readout. You can scroll back to see previous entries by using the 
"scroll bar" to the right of the "tally roll".

The currently selected transaction is indicated by a small blue ">" sign, and any entries or results that
have notes attached to them are indicated by a small green "pin". Subtotals are shown with a small 
"s" to the right, totals with a small "t". Values automatically calculated by using one of the three "tax" 
buttons are shown with a small "a", "b" or "c" to the right of the digits. A count of entries in the current 
sequence can optionally be shown in brackets to the left of the entered digits.

The first line of any notes attached to entries can be quickly displayed by holding down the right hand
mouse button while the mouse pointer is over the "tally roll".

The colors of entries/results etc. can be changed by use of the "Options" menu.

The currently selected entry can be modified or additional entries can be inserted by using the 
"Entries" menu. Modifications or additions cause the complete sequence on the "Tally Roll" to be 
recalculated.

The "tally roll" can be saved and re-loaded and calculations continued, and the tally roll can be 
printed, or copied to the Windows Clipboard.



Memory Selector
The memory selector allows you to select which of the ten available memories to make the "active" 
memory. The memory display changes to reflect the content of the newly selected memory.

Keyboard Shortcuts - "Alt 0 to Alt 9"



"New" button
This button completely resets the calculator and clears the "tally roll". Note that no warning is given, 
so you should save any work you wish to retain before usng this button.

Keyboard Shortcut - "Alt W"



Minimize Button
You can use this button to "Minimize" SmartSum to an Icon. All calculations and entries are 
preserved, ready for re-use when you "restore" Smartsum by double-clicking on its Icon.



The "=" key
Pressing the "=" key causes the calculation to be undertaken, and if selected via the Options menu a 
subtotal will automatically be inserted onto the "Tally Roll".

Keyboard Shortcut - "The Enter Key, or the = key"



The "SQRT" key
This key calculates the square root of the current number shown in the main readout. Note that you 
cannot have a square root of a negative number.

Keyboard Shortcut - "Alt Q"



Control Menu
This standard Windows feature allows you to minimize, move or close SmartSum, or switch quickly 
to the Task Manager and from there to another application.



Smartsum Caption
This standard Windows feature provides the name of the program (SmartSum) and the name of any 
currently loaded calculation file (*.SSC).

You can use the caption bar to move SmartSum around your screen. Position the mouse pointer over
the caption bar, depress the left mouse button, and then drag SmartSum to the desired location.



The "C" key
Clears the current calculation, advancing the "tally roll" by a single line.

Keyboard Shortcut - "Esc"



The "CE" key
Clears the current entry on the main display to "0". Note that this only clears a number you have 
keyed yourself. You cannot clear the result of a calculation using this key.

Keyboard Shortcut - "Del"



The "<" key
This is the "backspace" key, and removes the last digit keyed by the user.

Keyboard Shortcut - " <-" (the backspace key to the right of the # key)



The digit keys
These keys enter the digits as shown.

Keyboard Shortcut - the digit keys, either on the numeric keypad (with Num Lock set), or along the top row of the 
keyboard.



Operator Keys
These keys perform the addition, subtraction, multiplication, division and percentage operations.

Note that the percentage key performs a different operation depending on the previous operator. 

For example , the sequence "200 + 20 % =" causes the % key to calculate 20% of 200 and then add 
it to 200 (i.e. mark-up by 20%). The sequence 200 * 20% = causes    the calculation of 20% of 200, 
i.e. 40.

Keyboard Shortcuts - The + - / * and % keys



The "+-" (sign-switch) key
The sign-switch key causes the previously entered number to have its sign switched from positive to 
negative or vice-versa. This enables you for example to multiply by -5 by using the keystrokes * 5 
(sign-Switch) =.

Note that you can only use this key to change the sign of numbers you have entered yourself, and 
not the results of calculations which would then be inconsistent with the results on the tally roll. if you 
need to change the sign of a calculated result then multiply by -1.

Keyboard Shortcut - "Ctrl -"



Order Form - SmartSum R1.5

Call +44 (0)270 759739
Fax +44 (0)270 765272
CIS: 74774,1347
You can print this order form by using the "Print Topic" option from the "File" menu.

You will receive:-

· A copy of the latest registered version of SmartSum, without the reminder screens. Whilst we 
always try to ship as quickly as we can, by Air Mail if outside the UK, please allow 21 days for 
delivery.

· Shareware versions of some of our other software, including at least SmartCat Plus - the premier
Windows File Cataloger, Smart Address - a very sophisticated Address Book/Mailing List 
Manager, and SmartDoc - a Windows Help File printing/Text extraction utility, plus whatever else 
we have that will fit on the disk.

We can accept your order by mail, E-mail, Fax or Phone. You can also register single copies via the 
Compuserve SWREG service (GO SWREG), using Product ID 2705. The cost via SWREG is $35.00
(Thirty Five US Dollars). Unless otherwise requested we ship a 3.5" disk.

We also offer considerable discounts for multi-copy licences for use across 
networks, across sites or across corporations. Please contact us for details 
on +44 (0)1270 759739.
Send your order to:-
Oakley Data Services,
3 Oakley Close,
Sandbach,
Cheshire CW11 9RQ,
England.

Please send me __ registered copy(s) of SmartSum.

Price :- £23.50 Pounds Sterling.
(In the EEC this is made up of 20.00 Pounds, plus VAT @17.5%, no charge for shipping. In the rest 
of the world this is made up of 20.00 Pounds, plus 3.50 Pounds Air-Mail Shipping + Handling).

(As of September 1994 the exchange rate was approximately 1.5 U.S. Dollars to 1.0 Pound Sterling. When we charge your 
credit card the card company will convert the cost to your local currency at the rate then prevailing and the sum will appear on 
your bill in your local currency.)

Total Price : .......................
I enclose a cheque / wish to pay by MasterCard / Visa / Amex (delete as applicable)

(Note: We can only accept cheques payable in the UK drawn in Sterling.)
Credit Card Details:-
Name as on card:-



Card Number:- 
Expiry Date:-

Please send the registered version to:-
Name:
Address:

Post/Zip Code:                                                Day Time Tel. No.

You can also contact us by:-
Phone:+44 (0)1270 759739; FAX: +44 (0)1270 765272; Compuserve: 74774,1347
Internet: 74774.1347@compuserve.com ,
or via Section 4 of the UKSHARE forum on Compuserve.

It would also help us if you could tell us where you got SmartSum from:-

And any suggestions you have for enhancements:-



Order Form - SmartSum R1.5

Call 801 295-1890 
Fax 801 299-1781

You can print this order form by using the "Print Topic" option from the "File" menu.

We can accept your order by mail, E-mail, Fax or Phone.    Unless otherwise requested we ship a 
3.5" disk containing a licensed copy of the latest version of SmartSum R1.

We also offer considerable discounts for multi-copy licences for use across 
networks, across sites or across corporations. Please contact us for details at
801 295 1890.
Send your order to:-
Insight Software Solutions
P.O. Box 354,
Bountiful, UT 84011-0354

Or Call 801 295-1890 
Or Fax 801 299-1781
Or CompuServe:    71672,3464

Please send me __ licensed copy(s) of SmartSum R1.
Price Per Copy:-

Price                          $29.00 
Utah Residents add Sales Tax   $ 1.78 
Shipping by Fist Class Mail    $ 3.00
       --- or ---
Priority or Int'l shipping     $ 5.00
-----                          ------
Total                          $       
-----                          ------

All Prices are in US Dollars.

I enclose a check / wish to pay by MasterCard / Visa (delete as applicable)

Credit Card Details:-
Name as on card:-

Card Number:- 

Expiry Date:-

Please send the registered version to:-



Name:

Address:

Telephone Number.

It would also help us if you could tell us where you got SmartSum from:-

And any suggestions you have for enhancements:-






